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Safety Precautions

The precautions noted within this guide are intended to instruct you in the safe and
correct use of the products and to prevent injuries or damage to yourself, other
persons and property. Please read and ensure that you understand them before
proceeding to other sections of the guide.

H This symbol indicates topics that could lead to death or serious injury if ignored
Awa rn | n g or handled incorrectly.

/AWarning

Do not play the supplied CD-ROM(s) in any CD player that does not support data CD-ROMs. Playing the
CD-ROM(s) in an audio CD player (music player) could damage the speakers. It is also possible to suffer

from hearing loss from listening with headphones to the loud sounds of a CD-ROM played on a music CD
player.

Disclaimer

* While every effort has been made to ensure that the information contained in this guide is accurate and
complete, no liability can be accepted for any errors or omissions. Canon reserves the right to change
the specifications of the hardware and software described herein at any time without prior notice.
No part of this guide may be reproduced, transmitted, transcribed, stored in a retrieval system, or
translated into any language in any form, by any means, without the prior written permission of Canon.
Canon makes no warranties for damages resulting from corrupted or lost data due to a mistaken
operation or malfunction of the camera, the software, the CompactFlash™ cards (CF cards), personal
computers, peripheral devices, or use of non-Canon CF cards.

Trademark Acknowledgments

e Canon is a trademark of Canon Inc.
* iBook and iMac are trademarks of Apple Computer, Inc.

Macintosh, PowerBook, Power Macintosh and QuickTime are trademarks of Apple Computer Inc.,
registered in the United States and other countries.

Other names and products not mentioned above may be registered trademarks or trademarks of their
respective companies.

Copyright © 2004 Canon Inc. All rights reserved.

Symbols Used in This Document

Indicates important items or prohibited actions that should always be observed when
0 operating the machine. These should always be read to avoid damage to the
machine or improper operation.

|§| Indicates items for reference or supplementary information that should be noted by
users.




Read This First

About the Manuals

This user guide describes how to connect the printer to your computer and
print images.

Provides printer handling notes, safety precautions,
printer preparation, names of parts and other information

necessary for operating the printer. Please read before

Printer . .
(CP-330/CP-220) using the printer.
User Guide
D-RO ) .
Describes how to connect the printer to your computer,
printer driver installation, functions and operating
- procedures.

This user guide

Explanations for Mac OS X are based on Mac OS X v10.1. If you are using
another version of Mac OS X, the actual screen contents and procedures may
vary slightly from those shown.

Detailed explanations of operating procedures are given in the [Help]
accompanying each software application.

i If a problem occurs, refer to the following:

 Trouble with the printer itself: &~ See the Printer User Guide.
¢ Printing problems: 3~ See this user guide.



Printing Flow Diagram

Follow the steps outlined below to prepare the printer and install the
necessary software on your computer to enable printing.

Prepare the printer.

Insert paper cassette and ink cassette.

3 See the Printer User Guide.

$

Install the necessary software on your
computer.

Install the necessary software on your computer from the CP
Printer Solution disk.

3 See the Printer User Guide.

Install the printer driver.
lD ’V Install the printer driver onto your computer.
(EEEEy 3 See

Installing the Printer Driver (= p.8) in this user guide.

‘ To uninstall the printer driver,
3" see Uninstalling (= p.11) in this user guide.

Turn the printer’s power on.

Turn the printer's power on and connect the printer to your
computer.

3" See
Turning On the Printer (= p.14),
Connecting the Printer to Your Computer (= p.15) in this user guide.

Continued next page.




Select an image to print.

Start ImageBrowser and select an image to print.

3 See
Starting ImageBrowser (Mac OS 9.0 - 9.2 = p.18, Mac OS X = p.37),
Selecting an Image for Printing (Mac OS 9.0 - 9.2 = p.19, Mac OS X = p.37)

in this user guide.

Print on standard sheet or full-size labels.

3~ See

Selecting a Layout Type

(Mac OS 9.0 - 9.2 = p.20, Mac OS X = p.39)
Setting the Printer Driver for Printing

(Mac OS 9.0 - 9.2 = p.23, Mac OS X = p.42)

in this user guide. *

To print an 8-label sheet,

3 see

Printing Duplicate Images on an 8-Label Sheet

(Mac OS 9.0 - 9.2 = p.27, Mac OS X = p.46) or

Printing Different Images on an 8-Label Sheet

(Mac OS 9.0 - 9.2 = p.30, Mac OS X = p.49) in this user guide.

About the Connection Cable

The printer can be connected to a computer using a standard USB cable.
For details, see Specifications (Interface) in the Printer User Guide.



Installing the Printer Driver

This section describes how to install the printer driver on your computer.

@ For details on how to uninstall the printer driver, see Uninstalling (= p.11)

Installing

Close any programs that are running.
Place the Canon CP Printer Solution Disk in the CD-ROM drive.

With Mac OS 9.0 - 9.2, double-click the [Canon CP Printer Installer]
icon in the [Mac OS 9] folder on the CD-ROM.

With Mac OS X, double-click the [Canon CP Printer Installer] icon
in the [Mac OS X] folder on the CD-ROM.

The installer panel appears.

Canon CP PRINTER

Solution Disk

” —
2 . g g Application Software

S 7 N
'&‘\ \\ { Install
ol - I ; S ————————

CP Printer Driver

Install

Exit

Click the CP Printer Driver [Install] button.

Read the software license agreement. If you agree to all of its
conditions, click the [Agree] button.
The installer starts.



6 Select [Easy Install], and then click the [Install] button.

CP Installer=——————H B

-

(| Easy Install a

Clicking the Install button installs the following items:
o CP Printer Driver
o Printer driver utilities

Disk space available: 905, 240K Approximate disk space needed: 2,472K

— Install Location
Quit
Herns will be installed on the disk "English”
).

S

i

7 Click the [Continue] button to automatically close any applications
other than the installer.

this installation. Click Continue to
automatically quit all other running
applications. Click Cancel to leave your
disks untouched.

 ——
C )

@ No other applications can be running during

8 Follow the messages on the screen to proceed.

9 When installation is completed, click the [Restart] button.
Before the printer driver will operate, you must restart your computer.

Installation was successful. You have installed
software which requires you to restart your
computer. If you are finished, click Restart, or if you
wish to perform additional installations, click

Continue.
Z X
([(__Restart_J]




B With Mac OS X

Continuing from the above procedure, do the following:

1)
2)

3)
4)
5)
6)

7)

8)

9)

Turn the printer’s power on. (= p.14)

After your computer restarts, connect the printer to computer with the USB
cable.

For information on how to connect the printer, see Connecting the Printer to
Your Computer (= p.15).

Double-click the hard disk icon where Mac OS X is installed.
Double-click the [Applications] folder.
Double-click the [Utilities] folder.

Double-click the [Print Center] or [Print Setup Utility] icon.
The Printer List window appears.

Click the [Add Printer] or [Add] button.

86868 Printer List
© ["Name & kind Status
® [cr330 CP Printer

Delete Add Printer...

4
Select [USB], select the printer name, and then click the [Add] button.

Printer List

! - 1 kind
@ CP Printer

Printer Model: _Auto Select.. *

Close the window by clicking a in the upper left-hand corner.

10 }



To uninstall the printer driver, use the installer.

Uninstall the printer driver if it is no longer needed, or if a problem occurs
0 and uninstalling becomes necessary. Note that if you uninstall the printer
driver, you will no longer be able to use the printer to print.

Important
Be sure to follow the procedures described in this section to uninstall the printer.

1 Close any programs that are running.

N

Place the Canon CP Printer Solution Disk in the CD-ROM drive.

w

With Mac OS 9.0 - 9.2, double-click the [Canon CP Printer Installer]
icon in the [Mac OS 9] folder on the CD-ROM.

With Mac OS X, double-click the [Canon CP Printer Installer] icon
in the [Mac OS X] folder on the CD-ROM.

The installer panel appears.

Ccanon CP PRINTER

Solution Disk

5 l) ? Application Software
' :i S o ~
’\\\ ‘ ( Install )

CP Printer Driver

Install

Exit

Click the CP Printer Driver [Install] button.
Read the software license agreement. If you agree to all of its

conditions, click the [Agree] button.
The installer starts.

< " )



6 Select [Uninstall], and then click the [Uninstall] button.

CP Installer=——————H B

[ Uninstall +|)

Clicking the Uninstall button removes the following items:
o CP Printer Driver

o Printer driver utilities

Disk space available: 837, 316K Approximate disk space needed: 0K

— Install Location
Quit
Ierms will be uninstalled from the disk “English”
MU

—

S

i

7 Click the [Continue] button to automatically close any applications
other than the uninstaller.

No other applications can be running during

@ this operation. Cick Continue to
automatically quit all other running
applications. Click Cancel to leave your
disks untouched.

e
(Coontinue |)
—

8 After uninstallation has been completed, click the [OK] button.

The uninstall was successful. However, some
files/folders could not be deleted because they are
shared by other applications, are currently in use,or
contain files not installed by this install program.

< 12 )



B With Mac OS X

To continue, you must do the following:
1) Double-click the hard disk icon where Mac OS X is installed.
2) Double-click the [Applications] folder.
3) Double-click the [Utilities] folder.

4) Double-click the [Print Center] or [Print Setup Utility] icon.
The Printer List window appears.

5) Select the printer you uninstalled, and then click the [Delete] button.

868 Printer List

L= ¥ kind Starus
5@ CP Printer

(f Delete D( Add Printer.. \

7

6) Close the window by clicking E in the upper left-hand corner.

4 13



Turning On the Printer

Compact

At least 15 cm (6 inches) of Power Adapter

open space in the front and back,
and at least 10 cm (4 inches)
on the left and right.

Refer to the above figure during the following procedure (the numbers in the
figure correspond to the steps in the procedure).

1 Place the printer on a flat surface.
When printing, the paper temporarily projects out from the rear, so allow a clear
space of at least 15 cm (6 inches) in the back.

2 Connect the supplied power cord to the CA-CP100 Compact Power
Adapter (also supplied).

3 Plug the power cord into a power outlet.

Connect the Compact Power Adapter cable to the printer.
At this point the CP-220 is ON, so the printer’s indicator lights green.

5 Press the ON/OFF button (only on the CP-330).
When the printer is turned on, the printer's indicator lights green.

@ To Turn the Printer Off

¢ With CP-330: Press the ON/OFF button, releasing it when the indicator
turns off.

* With CP-220: Unplug the Compact Power Adapter from the printer
(the indicator turns off).

* When making connections, confirm that the shape of the plug matches
0 the shape of the socket on the device being connected.

* The power outlet where the printer's power plug is connected should be
located where the plug can be easily removed if a problem occurs.

< 14 )



Connecting the Printer to Your
Computer

H Notes about connection

* Using the USB cable, be sure to connect the printer directly to your computer. If
you connect it via a USB hub, the printer may not function properly.

* Do not use the printer together with other USB devices (except a USB mouse or
keyboard); otherwise the printer may not function properly. If this happens,
disconnect the other USB devices from your computer and then reconnect the
printer.

* Do not connect two or more direct print compatible printers (all CP series
printers) to the same computer; otherwise the printers may not function properly.

to a USB port.

If you accidentally do so, do not disconnect the USB cable from your
computer while it is in the sleep mode; instead, leaving the USB cable
connected, first return your computer to its normal mode. If you remove the
USB cable while your computer is in the sleep mode, your computer may
not be able to return to its normal mode. For details on your computer’s
sleep mode, refer to the documentation provided with your computer.

0 Do not put your computer into the sleep mode while the printer is connected

< 15 )



Connect one end of the USB cable to the USB port on the printer,

and the other end to a USB port on your computer.

* There is no need to turn off the printer or your computer.

* When connecting the printer to your computer, make sure the connectors on
the ends of the USB cable match the ports on the printer and your computer.

¢ For the location and direction of your computer's USB port, refer to the
documentation provided with your computer.

which USB port you use to connect the printer.
e There is no need to turn off the printer or your computer when
disconnecting the USB cable.

@ * If your computer has more than one USB port, it does not matter

16 >



Printing

This section describes how to use ImageBrowser to print images with the
printer.

ImageBrowser is an application included on the Canon CP Printer Solution
Disk. This application makes it easy to print.

Before printing, verify that the printer is on (the indicator on the printer is green),
and that the printer is properly connected to your computer with a USB cable.

Printers and computer displays use different color reproduction methods,

0 and lighting conditions and display settings affect the appearance of colors
on your computer’s display. Therefore, the colors in prints may differ from
what you see on the screen. This is not a printer malfunction.

@ For information on how to install ImageBrowser, see the Printer User Guide.

The screen examples and descriptions given in this section are for
the CP-330. Operate the CP-220 in the same way.

< 17 )



With Mac 0S 9.0 - 9.2

Selecting a Printer with the Chooser

1 Open the ® (Apple) menu and select p [Chooser].

2 Click the [CP Printer Driver] icon.
If the printer is connected, it appears in the [Destination] list.

=] %Cmmser =——1*H

\ Destination l USB
’ o CP-330

AppleShare

'~

cP-10 Lasertiriter 8

A

@ Active
Q) Inactive 7.6.2

D]

AppleTalk

3 Click the CP-330 or CP-220 in the [Destination] list, then close the
Chooser dialog by clicking ] in the upper left-hand corner.

Starting ImageBrowser

1 Double-click the [Canon ImageBrowser] icon on the desktop.
If the [Canon ImageBrowser] icon does not appear on the desktop, double-click
the [Canon Utilities] folder, [ImageBrowser] folder, and [ImageBrowser] icon.

< 18 )



Selecting an Image for Printing

1 Selectan image you want to print from the browser area. Click the
k&5 (PRINT) button to display a menu. From the menu, select

[Layout printing].
o  Browser Window =]
(& canon Camera View Mode : st =
b = English

33060003.JPG

Browser
area

33130000.JPG

s mer 00 i puwme  osee iy

i [« v

When the CP-220 or CP-330 is selected, you cannot select [Index printing].

The Print window and Layout Options window appear.

O=————mnt—— B

Print window
You can check the
layout of the image.

Layout Options

Q) Custom layout printing

@ Photo printer standard printing

) Photo printer multiple printing

Print one image over the entire page.

Layout Options
window

You can adjust the
settings for printing.

[ Display this dialog when the Printing window displays

s

K0

o 8 <

. IMAGES Lavout
RELAYOUT  ROTATE,  pepeuce oPTiors  RMT

< 19 )
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Selecting a Layout Type

This section describes how to select a layout type, and then print on
standard sheets or full-size label sheets. For information on how to print on
8-label sheets, see Printing Duplicate Images on an 8-Label Sheet (= p.27)
or see Printing Different Images on an 8-Label Sheet (= p.30).

1 Select“Photo printer standard printing” in the Layout Options
window and then click the [Next] button.

Layout Options

(&) Custom layout printing

< EE Photo printer standard printing >

(3 Photo printer multiple printing

Print one image over the entire page.

[4 Display this dialog when the Printing window displays

Crets ]
| —

you to freely specify the size and position of images for printing. You can
also use this option to add text in the Print window to create greeting
cards and so on. There are 3 methods for adding text, as shown below.

* To add a caption to an image: Click the image and select [Edit
Caption] from the [Edit] menu.

@ Selecting “Custom layout printing” in the Layout Options window allows

* To edit the page title: Select [Edit Header] from the [Edit]
menu.
¢ To insert text: Select [Add Text] from the [Edit] menu.

2 Click the [Page setup] button.

< 20 )



3 Make [Paper Size] and [Orientation] selections, and then click the

[OK] button.

Select the paper

size.

Canon CP-330 Page Setup
—{ Page Attribute 15}
Page Size: Postcard(4x6in) ¥
Orientation: E}
Display Page Size
o )

|_ Select the paper
direction.

4 After returning to the Layout Options window, select “Bordered”

or “Borderless”, then click the [OK] button.
If you select “Bordered”, the image is automatically resized to fit within the print.

Layout Options

Paper size :
Height4.11 X Width6.03inch

Page setup...

) Borderless
@ Bordered

Confirm the page setup and select
between [Borderless] and [Bordered].

— Preview

[ Display this dialog when the Printing window displays

cancel | | <Back | ‘“

21



The layout settings are reflected in the Print window.

O=——————rrint

HE

AT

2 wu (98]0

IMAGES LAYOUT
RE-LAVOUT - ROTATEL oo tane OPTIONS

<

FRINT

Sl

*The image shown is bordered.

22

[LAYOUT OPTIONS] button
Redisplays the Layout Options
window, where you can change
the settings.



Setting the Printer Driver for Printing

This section describes printing with modified printer driver settings.

Click the & (PRINT) button.

| A~
5 . [18 <
%
2 Select [Color].
Printer: [ CP-330 4] Destination: [Printer [ 2]
Profiles: 4 Default Settings B
alor > 4
Page: @ All Pages o«-->|Z|
copies: 1|
[Preview | [ cancel |[[ print ||

3 To adjust image quality, select [Custom].

Frinter:  [CP-330 4] Destination: [Printer | 2]
Profiles: [ 4 Default Settings i]
— color 15}

The default is

-magequauw(ﬁ (s
Non adjustment
\ - j

preview | [ cancel | [ print_ ||

Custom
Click the [Adjust] button to adjust image quality freely.

23

[Non adjustment].



4 After selecting [Custom] and clicking the [Adjust] button, adjust
the brightness and color of the print result, then click the [OK]

button.

For details, check the balloon help.

Quality adjust="="———————

i Color Adjustment

Saturation: 0

Hue: R nI
G ur
B u.

Brightness & Contrast
Brightness: 0 4%

contrast: 0 (B

Adjust the color of
prints.

] Adjust the brightness

Revert ]

[ cancel ]@

and contrast of prints.

5 select [Background Printing] and select a printing method.

Destination:

Printer

Select [Background

Printer; [ CP-330 E
Profiles: >
Background Printing )]

Printing] to print in the
background. This allows

Printing Method: Spooling)
@ Background

you to use other
applications while
printing.

Revert

Preview ] [ Cancel ]H

Print_ ||

24



Select [General], set the various options, and then click the [Print]

button.
Verify that the CP-330 or CP-220 is selected in [Printer]. For [Destination], you
can select the following types of output.

Printer: Output is directed to the printer.
File: Output is directed to a PICT file.

When printing in the background, printing cannot be resumed if the
printer runs out of paper while printing. To avoid this, load more sheets
of paper than required for the number of images to be printed.

Frinter:  [CP-330 4] Destination: [Printer | 2]
Profiles: [ 4 Default Settings i]
(Teneral - When multiple images
are selected, specify the
Fages @Al Pages o=l Td pages (images) to be
copies: 1 ][] printed.

To print multiple copies
of images, enter the
number of prints desired.

Revert Preview I Cancel K Print ’

Printing starts.

o

If you stop printing while printing is in progress, paper is ejected to the
paper handling slot and an error message may be displayed. This is not a
malfunction, but a mechanism for protecting the print head.

If you interrupt printing while it is in progress, be sure to check the printer
status.

* When the indicator light is green:
You can continue to print.

e When the indicator light is red:
Temporarily remove paper from the paper handling slot. Turn the
printer off and then back on again. Make sure the indicator light is now
green, and then print again.

Note that when printing is interrupted, one print's equivalent of the ink
cassette's ink sheet is used.

25 }



Registering Profiles

You can save [Color] and [Background Printing] settings as [Profiles].

H To register a profile

1 Make [Color] and [Background Printing] settings.

2 Select [Add Profile] from the [Default Settings] menu, type in a
name and comment, and then click the [OK] button.

Printer: Destination: m
Profiles: >
——| Add Profile...
Pages]  aqd profile
Copies:|  yame: Untitled )
Comment:
[=]
|~
g—
()]s
Revert — IIl

< 26 )



Printing Duplicate Images on an 8-Label Sheet

ImageBrowser allows you to print duplicate images. This makes it possible
to print multiple copies of the same image on an 8-label sheet.

1 Inthe Layout Options window, select “Photo printer multiple
printing”, and then click the [Next] button.

Layout Options

() Custom layout printing

(2 Photo printer standard printing

((® Pnoto printer murtiple printing ) ﬁ@@ @
Print on labels. @@ @@

[ Display this dialog when the Printing window displays

—
C_ o)
S

2 Click the [Page setup] button.

Layout Options

— Preview

Confirm the page setup.

Paper size :

Height2 24 X Width3.47inch
—
(| Page setup... ’

[ Display this dialog when the Printing window displays

cancel | [ cBack | | oK |

< 27 )



3

4

For [Paper Size], select [CP_C size (L)], select the orientation, and
then click the [OK] button.

After returning to the Layout Options window, click the [OK]
button.

Images are resized to fit the label dimensions and are displayed in the Print
window.

Click the image and select [Copy Image] on the ImageBrowser
[Edit] menu.

int=——HH

4[]

il [=]

= B[4 %]
IMAGES LAYOUT
PER P &GE OFTIONS

RESLAYBUTSRLLALES

ol

28 }



6 Enter 7 and click the [OK] button.

Copy

Copies the selected image.
Select or input the number of copies.

()
[ cancel 1|¢|'

The images are laid out in replicate, with their positions adjusted for the eight
labels on the 8-label sheet.

O=—————————pmit———HE

LAYOUT
OPTIONS ERIT ’7

= OB 8
%

IMAGES:
PER P AGE

R ROTATE
RE-LAYOUT e

7 Click the & (PRINT) button to start printing.

< 29 )



Printing Different Images on an 8-Label Sheet

You can also print a combination of different images on an 8-label sheet.

1 Inthe Layout Options window, select “Photo printer multiple
printing”, and then click the [Next] button.

Layout Options

() Custom layout printing

(2 Photo printer standard printing

(@ Pnoto printer multiple printing ) ﬁ@@ @
Print an labels. @@ @@

[ Display this dialog when the Printing window displays

o D
=

2 Click the [Page setup] button.

Layout Options

— Preview

Confirm the page setup.

Paper size :
Height2 24X Width3.47inch

‘ Page setup... | )
—_—

[ Display this dialog when the Printing window displays

[ cancel | [ <Back | | oK |

3 For [Paper Size], select [CP_C size (L)], select the orientation, and
then click the [OK] button.

< 30 )



4 After returning to the Layout Options window, click the [OK]
button.

5 From the browser area, drag and drop the images to be printed
onto the Print window.
The different images are laid out with their positions adjusted for the eight labels
on the 8-label sheet.

O=————————mint=—-<—"=08H8

' '
LavouT
OPTIONS

I s
e N =
= L, E‘
IMAGES
PER PAGE

- T ROTATE
RE-LAYOUT e

6 Click the €3 (PRINT) button to start printing.

< 31 )



Merging Images to Print a Panorama

You can create panoramic images by merging multiple images, and then
printing them on wide paper. This operation is performed using the
PhotoStitch software.

mode, PhotoStitch determines the order and direction of the composition

@ When you use images captured with a Canon digital camera in Stitch Assist
automatically, facilitating the composition process.

1 oOpen ImageBrowser and select the series of images you want to
merge from the browser area.

2 Select [PhotoStitch] from the [Edit] menu.
PhotoStitch starts.

3 Merge the images following the instructions in the guidance panel
at the top of the PhotoStitch window.

4]

Photo5ti toh aaaa—i—i——"———=—_r 8

Merge Images Shot in Stitch Assist Mode .
Click [2. Merge] to merge these images Instructions
For images shot as @ 360-degree panorama, click [Arrange], select
[360 Degrees] and then click [2. Merge]

<[]

No_of Images: 4| [

N

4 save your panoramic image, and then close PhotoStitch.
5 Print the panoramic image.

@ To print the merged images, see Selecting an Image for Printing
(= p.19).

< 32 )



Printing Part of an Image (Trimming)

You can select and then print a portion of an image (trimming).
This is useful when you only want to print part of an image, or if the part you
are most interested in is not at the center of the image.

* The length-to-width ratio cannot be modified if you select “Photo printer
standard printing” in the Layout Options window, and then specify
“Borderless”, or if you select “Photo printer multiple printing”. Also,
because a 1 - 3 mm border is trimmed from the image during printing, we
recommend that you select an area that is slightly larger than the part of
the image you want to print.

@ * You can print portions of images selected from any type of layout.

1 Click the image you want to print, then select [Clipping] on the
ImageBrowser [Edit] menu.

Print

2 0B BB 9

IMAGES LAYOUT
X ROTATE
RE-LAYOUT v FER PAGE OPTIONS LRI

N
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2 Select the portion of the image to be printed, then close the
Clipping window.

A After selecting the
ﬂla%@mppngE |_p0rtion to be
printed, this closes
_________________________________________ : the window.

.,
¥
~- |

“ The area inside the
dotted line is the

portion of the image
to be printed.

VERTICAL
CLIPFING

= Q @ Changes the size of
- REDUCE ENL ARGE the Wlndow-
|

436282 (646, 528) | Display: _ 75% 2

[l
Image Size: _ B52x624 | |

==

Clicking here changes the orientation of the trim frame.
These buttons do not appear when “Bordered” is selected.
One orientation or the other is selected by default when “Bordered” is not selected.

The Clipping window closes and the selected area appears in the Print window.

O=————pmnt=—HH

[ ILiF-

g 4]

. H <
= B

IMAGES LayouT

RE-LAYOUT  ROTATEL oo bage OPTIONS BRI

Z

3 Click the & (PRINT) button to start printing.
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Printing with Image Quality Correction

ImageBrowser has a function that supports Exif 2.2 (referred to as Exif Print),
allowing you to automatically optimize print quality and print clearer, better-
looking images.

The image quality correction is adopted for all images printed from
ImageBrowser.

1 Click the image you want to print, and select [Preferences] from
the ImageBrowser [Edit] menu.

Print

| S
' 4 H <
=k
IMAGES LAYOUT
RE-LAVOUT  ROTATEL oo cne OPTIONS

FRINT

%
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2 Select [Print] in the Preferences window, set image quality
correction, and then click the [OK] button.

Be sure to select the check box
when using image quality correction.

Preferences

Print s ———
C =D Automatically corrects
— Image Correction Settings -m- . .
[ Use Image Correction —I images captured with
) Use Photo Optimizer PRO and Exif Print EXIf 22 compatib|e
@ Use Exif Print for Exif 2.2 Photos
cameras and other
— Items to Print in Caption .
images.

[JShooting Date
[ 5hooting Time
[ File Name

— Amount of Extension for Perforated Paper (For Bubble Jet Printer)

Automatically corrects

:e:nmmendedvﬂlza';"mmm only images captured
with Exif 2.2 compatible
_ Default Print Window Direction of Rotation
@ Rotate Left @ 3 Rotate Right @ cameras.
Select the direction of rotation for images shot with the camera
upended.

Select [Rotate Left] or [Rotate Right] to rotate the image 90 degrees in
the respective direction as viewed from behind the camera.

3 Click the & (PRINT) button to start printing.

Camera information such as scene and photographic conditions are

|§| embedded in images captured with cameras compatible with Exif 2.2
(referred to as Exif Print). This information can be passed onto the
printer through ImageBrowser (Exif Print-compatible software) so that
prints are clearer.
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With Mac OS X

Starting ImageBrowser

1 Double-click the [Canon ImageBrowser] icon on the desktop.
If the [Canon ImageBrowser] icon does not appear on the desktop, double-click
the [Canon Utilities] folder, [ImageBrowser] folder, and [ImageBrowser] icon.

Selecting an Image for Printing

1 Selectan image you want to print from the browser area. Click the
&5 (PRINT) button to display a menu. From the menu, select
[Layout printing].

006 Browser Window
(& Canon Camera View Mode (st )
b 5 Mac 0S X

33060003.JPG

Browser
area

33130000.JPG

g o B @« @ @3

o Vi CANONCAMERA  seLECT SRR REDUCE ENLARGE  DISPLAY IMAGE

Layout printing...
Index printing...

To use index printing, display the Index Printing window by clicking the

@ @ (PRINT) button and selecting [Index printing] from the menu that
appears. Set thumbnail and paper sizes, then click the [Start printing]
button to start index printing.
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The Print window and Layout Options window appear.
[ ER)

Layout Options

( [ Prints to the Cano

n Compact Photo Printer ))

© Custom layo
® Photo printer|
O Photo printer|

Print one image

printing

tandard printing

nultiple printing

ver the entire page.

Print window
You can check the
I layout of the
image.

Layout Options
window

[ Display this dialof) when the Printing window displays
o)  Cancel )

( Next> )

= B 18 B ©
== i \

IMAGE
RE-LavOUT  ROTATEL  ooppage OPTIONS

When [Prints to the Canon Compact Photo Printer] is not
displayed, install the CP-330 or CP-220 printer driver (= p.8).

38

You can adjust the
settings for
printing.



Selecting a Layout Type

This section describes how to select a layout type, and then print on
standard sheets or full-size label sheets. For information on how to print on
8-label sheets, see Printing Duplicate Images on an 8-Label Sheet (= p.46)
or see Printing Different Images on an 8-Label Sheet (= p.49).

1 In the Layout Options window, select “Prints to the Canon
Compact Photo Printer”, select “Photo printer standard printing”,
and then click the [Next] button.

Layout Options

(E Prints to the Canon Compact Photo Prin[e)

) Custom layout printing

(@ Photo printer standard printinQ

() Photo printer multiple printing

Print one image over the entire page.

E Display this dialog when the Printing window displays

f?\ Cancel \

@ Selecting “Custom layout printing” in the Layout Options window allows

(

you to freely specify the size and position of images for printing. You can
also use this option to add text in the Print window to create greeting
cards and so on. There are 3 methods for adding text, as shown below.

* To add a caption to an image: Click the image and select [Edit
Caption] from the [Edit] menu.

¢ To edit the page title: Select [Edit Header] from the [Edit]
menu.
* Toinsert text: Select [Add Text] from the [Edit] menu.

2 Click the [Page Setup] button.
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3

In [Format for] select [CP-330] or [CP-220], make [Paper Size] and
[Orientation] selections, and then click the [OK] button.

Page Setup
settings: | Page Attributes Hq
Select [CP-330] or
Format for. [ CP-330 F——————[cP-220].
Canon CP-330
Paper Size: | Postcard(4x6in) ¥ j— Select the paper size.

Orientation:

Scale:

4.11in. x 6.03 in.

— " : Select th
] arection.

@
2

100 %
{ Cancel )

After returning to the Layout Options window, select “Bordered”
or “Borderless”, then click the [OK] button.
If you select “Bordered”, the image is automatically resized to fit within the print.

Layout Options

Confirm the page setup and select
between [Borderless] and [Bordered].

Paper size :

Height104.3 X Width153.1mm

f Pace Setun . )
Page Setup... |

) Borderless
@ Bordered

— Preview _

@ Display this dialog when the Printing window displays

—
Cancel ) [ <Back ,
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The layout settings are reflected in the Print window.

8eesé Print

[LAYOUT OPTIONS] button
Redisplays the Layout Options
window, where you can change
the settings.

L

LAYOUT

OPTIONS ERINT:

Bk B %]

RE-LAYOUT  ROT ATEv

*The image shown is bordered.
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Setting the Printer Driver for Printing

This section describes printing with modified printer driver settings.

1 Click the &3 (PRINT) button.

PRINT
4

2 In [Printer] select [CP-330] or [CP-220].

1
a4

RE-LAYOUT

ROTATE
-

ln-jl -

LAYOUT
OPTIONS

“lr(

Print
Primer:( CP-330 =)
— — - —’
Presets: | Standard F‘
_VCopies & Pages E:!
Copies: |1 1 @Cul\ated
Pages: @ All
O From: |1 tw: 1
@ (Freview\' fEan(el? f Print )
3 select [Color].
Print
printer: | CP-330 ﬂ
Presets: | Standard Fi
Color ?’!'l
Copies: |1 ECUI\ated
Pages: @ All
O From: |1 tw: 1
@ “Preview (cancel ) € Print )

42
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4 To adjust image quality, select [Custom].

Print
Printer: | CP-330 |
Presets: | Standard Fi
_[calor ﬂ
Image quality; ( Adjust... ) The default is
Non:adinsiment [Non adjustment].
@ (“Preview ( cancel ) EPrint )

Custom
Click the [Adjust] button to adjust image quality freely.

5 Atfter selecting [Custom] and clicking the [Adjust] button, adjust
the brightness and color of the print result, then click the [OK]
button.

For details, check the help menu.

Quality adjust

Color Adjustment

Saturation: 0 V
Hue: & o = - : Adjust the color of
== l 5 prints.
= | 4
Brightness & Contrast
Brightness: 0 3¢ e o= -t ] Adjust the brightness
Contrast: 0 © q ] and contrast of prints.

i i
Revert ‘_ Cancel ‘@
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6 Select [Copies & Pages], and set the various options.

When printing in the background, printing cannot be resumed if the
0 printer runs out of paper while printing. To avoid this, load more sheets
of paper than required for the number of images to be printed.

Prin To print multiple
printer: [ CP-330 ﬂ copies of images,
enter the number of
Presets: | Standard ?‘ : f
prints desired.
(Cupies & Pages ?)
Copies: 1 @Col\ated When Selecting
Pages: @Al multiple images,
O From: |1 to: 1 .
specify the pages
(images) to be printed.
@ Preview ) " Cancel '\ € Print )

Selecting [Save Custom Setting] allows you to save the current settings for
[Copies & Pages], [Layout], [Output Options] and [Color]. For Mac OS X
v10.2/v10.3, the same settings can be saved when selecting [Save As] in

[Presets].
Print
Printer: [ €P-330 m
Presets: = Standard m
Save Custom Setting ﬂ,
Copies: 1 @Colla[ed
Pages: @ All
O From: 1 to: |1
@ 7 Preview " Ean(el? € Print )
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To use a registered setting, select [Custom]. For Mac OS X v10.2/v10.3,
select the name you entered after selecting [Save As] in [Presets].

Print

Printer: " g B
and

Presets

. Copies & Pages

Copies: ™ Collated
Pages: @ All

O From: |1 to: {1

@ Preview Cancel ) EFane)

Click the [Print] button.

Printing starts.

You can save data as a PDF file by selecting [Output Options], selecting
“Save as File” and then clicking the [Save] button.

Print

Printer: | CP-330

G}
Presets: | Custom )

f QOutput Options @

!Saw_ as File Format: PDF m

@ Preview ) Cancel )@
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Printing Duplicate Images on an 8-Label Sheet

ImageBrowser allows you to print duplicate images. This makes it possible
to print multiple copies of the same image on an 8-label sheet.

1 In the Layout Options window, select “Prints to the Canon
Compact Photo Printer”, select “Photo printer multiple printing”,
and then click the [Next] button.

Layout Options

(E Prints to the Canon Compact Photo Plin(er)

) Custom layout printing

) Photo printer standard printing

(@ Photo printer multiple pliming) ﬁ@@ @

Print on labels.

EDisplav this dialog when the Printing window displays

? 2 Cancel
Shuelc M —_————

2 Click the [Page Setup] button.

Layout Options

__ Preview _

Confirm the page setup.

Paper size :

Heightd Width123.3mm
gt W
Page Setup...

™ Display this dialog when the Printing window displays

.
» Cancel )
\{/ \

<Back ) oK )

3 In [Format for] select [CP-330] or [CP-220].

< 46 )



4 For [Paper Size], select [CP_C size (L)], select the orientation, and
then click the [OK] button.
Images are resized to fit the label dimensions and are displayed in the Print
window.

5 Atfter returning to the Layout Options window, click the [OK]
button.

6 Click the image and select [Copy Image] on the ImageBrowser
[Edit] menu.

868 Print

=5 <

| Layout
| OPTIONS

RE-L AY0OUT ROTATE
E-L AYOUT = FRINT

7 Enter 7 and click the [OK] button.

Copy

Copies the selected image.
Select or input the number of copies.

g
Cancel @
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The images are laid out in replicate, with their positions adjusted for the eight
labels on the 8-label sheet.

8eesée Print

; i} i
= g %
o o | -
1 5 LAYOUT

MAGES
RE-LAYOUT  ROTATEL  peg pace opTions TRMT

8 Clickthe & (PRINT) button to start printing.
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Printing Different Images on an 8-Label Sheet

You can also print a combination of different images on an 8-label sheet.

1 In the Layout Options window, select “Prints to the Canon
Compact Photo Printer”, select “Photo printer multiple printing”,
and then click the [Next] button.

Layout Options

(E Prints to the Canon Compact Photo antea

() Custom layout printing

) Photo printer standard printing

(@ Photo printer multiple plinling) ﬁ@@ @
Print on labels. @@@@

EDisplav this dialog when the Printing window displays

2 Caneel
=/ —

2 Click the [Page Setup] button.

Layout Options

__ Preview

Confirm the page setup.

Paper size :

Height93.1 X Width123.3mm
{_ Page Setup... ]

gbisplay this dialog when the Printing window displays

P

7 Cancel ) < Back ) OK

=

3 In [Format for] select [CP-330] or [CP-220].
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4 For [Paper Size], select [CP_C size (L)], select the orientation, and
then click the [OK] button.

5 After returning to the Layout Options window, click the [OK]
button.

6 From the browser area, drag and drop the images to be printed
onto the Print window.
The different images are laid out with their positions adjusted for the eight labels
on the 8-label sheet.

868 Print

Jj Ld, EI : @

IMAGES. LAYOUT
PER PAGE

= ITAT
SESNANE==RO TS OPTIONS

N

7 Click the &3 (PRINT) button to start printing.
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Merging Images to Print a Panorama

You can create panoramic images by merging multiple images, and then
printing them on wide paper. This operation is performed using the
PhotoStitch software.

mode, PhotoStitch determines the order and direction of the composition

@ When you use images captured with a Canon digital camera in Stitch Assist
automatically, facilitating the composition process.

1 oOpen ImageBrowser and select the series of images you want to
merge from the browser area.

2 Select [PhotoStitch] from the [Edit] menu.
PhotoStitch starts.

3 Merge the images following the instructions in the guidance panel
at the top of the PhotoStitch window.

eee PhotoStitch

Merge Images Shot in Stitch Assist Mode Instructions
Click [2. Merge] to merge these images.
For images shot as a 360-degree panorama, click [Arrange], select
[360 Degrees] and then click [2. Merge].

STA_D158.JPG STB_0158.JPG STC_0160.JPG STD_0161.JPG .

Noof | mages: 4 4

4 save your panoramic image, and then close PhotoStitch.

5 Print the panoramic image.

To print the merged images, see Selecting an Image for Printing
(= p.37).
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Printing Part of an Image (Trimming)

You can select and then print a portion of an image (trimming).
This is useful when you only want to print part of an image, or if the part you
are most interested in is not at the center of the image.

* The length-to-width ratio cannot be modified if you select “Photo printer
standard printing” in the Layout Options window, and then specify
“Borderless”, or if you select “Photo printer multiple printing”. Also,
because a 1 - 3 mm border is trimmed from the image during printing, we
recommend that you select an area that is slightly larger than the part of
the image you want to print.

@ * You can print portions of images selected from any type of layout.

1 Click the image you want to print in the Print window (= p.38),
then select [Clipping] on the ImageBrowser [Edit] menu.

868 Print

=1 H <
[
LAYOUT

RE-LAYOUT RUTP‘\TEv £ OPTIONS PRINT
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2 Select the portion of the image to be printed, then close the
Clipping window.
After selecting
@)3 o i Clipping |_the portion to be
printed, this

,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,,, closes the
] window.

The area inside
‘ the dotted line is
—————the portion of the
3 image to be
: printed.

Changes the
VEL%AL = “ size of the
CLIPPING REDUCE ENL ARGE Window-

Image Size:  B32xB24 | | A08x263 (794,296) Display.  75% 3

Clicking here changes the orientation of the trim frame.
These buttons do not appear when “Bordered” is selected.
One orientation or the other is selected by default when “Bordered” is not selected.

The Clipping window closes and the selected area appears in the Print window.
e 086 Print

alrl

= B
= e

= ROTATE
RE-LAYOUT =

<

LAYOUT

E OPTIONS ERINE

3 Click the & (PRINT) button to start printing.
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Printing with Image Quality Correction

ImageBrowser has a function that supports Exif 2.2 (referred to as Exif Print),
allowing you to automatically optimize print quality and print clearer, better-
looking images.

The image quality correction is adopted for all images printed from
ImageBrowser.

1 Click the image you want to print, and select [Preferences] from
the ImageBrowser [ImageBrowser] menu.

8686 Print

= B 18 H <

LAYOUT

AGE OPTIONS ERINE

- ROTATE
RE-LAYOUT =

2 Select [Print] in the Preferences window, set image quality
correction, and then click the [OK] button.

Be sure to select the check box
when using image quality correction.

Preferences

Print i
E ‘@ Automatically corrects
Cancel

— Image Correction Settings

8 Use image Correction — ——— images captured with
© Use Photo Optimizer PRO and Exif Print Exif 2.2 compatible
@ Use Exif Print for Exif 2.2 Photos cameras and other
__Items to Print in Caption .
[ Shooting Date Images.
[ shooting Time
) File Name
__ Default Print Window Direction of Rotation Automatically corrects
@ Rotate Left @ O Rotate Right @ only images captured
3:;'::1;:& direction of rotation for images shot with the camera W|th Ele 22 Compatib|e
Select [Rotate Lefi] or [Rotate Right] to rotate the image 90 degrees in cameras.

the respective direction as viewed from behind the camera.
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3 Click the & (PRINT) button to start printing.

Camera information such as scene and photographic conditions are

|§| embedded in images captured with cameras compatible with Exif 2.2
(referred to as Exif Print). This information can be passed onto the
printer through ImageBrowser (Exif Print-compatible software) so that
prints are clearer.
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mdices

About the Print Area and Pixels

Print Area

The shaded area () in the following diagrams indicates the maximum
printable area.

Note that because the print area is larger than the actual paper size, a
border is trimmed from the image when it is printed.

(shown in millimeters)

Postcard size sheet
2.0 3.0

2.0

100.0

2.0

148.0
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L size sheet
2.6 2.6

89.0

119.0 .

Credit card size sheet/full-size label sheet
1.0
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Wide size sheet

2.0 2.0

2.0

2.0

200.0

100.0

Number of Pixels

Paper Type Toftal number of Effec_tive number of
pixels (dots)* pixels (dots)

Postcard size sheet 1232 X 1808 approx. 1180 X 1748

L size sheet 1100 X 1456 approx. 1050 X 1406

oredit card size sheet 672 X 1066 approx. 638 X 1016

Wide size sheet 1232 X 2416 approx. 1180 X 2362

* Number of pixels of print area. This also includes the border that is
trimmed from around an image during printing.
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Troubleshooting
This section describes how to troubleshoot problems.

If the problem still exists after trying these solutions, restart your computer.
If the problem still persists, uninstall the printer driver and then install it again.

Printing does not start.

Cause : No power is supplied to the printer.

Correction : Make sure the indicator on the printer light is green. (= p.14)

Cause : The USB cable is not connected correctly.

Correction : Check the USB cable to make sure it is connected correcitly. (= p.15)

Cause : Your printer is not selected as the output destination
(Mac OS 9.0 - 9.2 only).

Correction : In the Chooser dialog, select the printer. (= p.18)

Cause : The queue is stopped. (When printing in the background)

Correction : Restart the print queue from the [File] menu of the Printer Monitor.

Printing stops while it is in progress.

Cause : The USB cable is not connected correctly.

Correction : Check the USB cable to make sure it is connected correctly. (= p.15)

Cause : A USB hub is being used for the connection.

Correction : Be sure to use the USB cable to connect the printer directly to your
computer. If you connect via a USB hub, the printer may not function
properly.

The color of an image seen on the screen is different from that

seen in prints.

Correction : Printers and computer displays use different color reproduction
methods, and lighting conditions and display settings affect the
appearance of colors on your computer’s display. However, you can
adjust color using [Adjust] (Mac OS 9.0 - 9.2 = p.24, Mac OS X
= D.43).
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Error Messages

If an error occurs while printing is in progress, an error message appears on
the screen of your computer.

This section contains a list of error messages as well as the information on
how to troubleshoot them.

solutions, consult your nearest Canon Customer Support Help Desk.
* Use the information in this section in conjunction with the Printer User
Guide.

@ * |f the error does not go away after you have tried the recommended

M Errors where printing can resume

If any of the following messages appear, printing can still resume. After
using the recommended solution to clear the error, printing restarts
automatically.

Printer error

Ink cassette is empty.
To resume printing, insert a new ink cassette.

Cause : There is no more ink in the ink cassette.

Correction : Replace the ink cassette with a new one.

Printer error

No ink cassette installed in printer.
To enable printing, insert an ink cassette.

Cause : The ink cassette is not inserted into the printer.

Correction : Insert the ink cassette into the printer.
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No paper.

Check that paper is correctly loaded in the paper cassette,
and that the paper cassette is correctly installed.

Cause : The paper cassette is not inserted correctly.

Correction : Remove the paper cassette, and then insert it back into the printer
correctly.

Cause : Paper is not inserted correctly in the paper cassette.

Correction : Remove the paper, and then insert it back into the paper cassette
correctly.

Cause : There is no paper in the paper cassette.

Correction : Add more paper to the paper cassette.

When printing in the background, printing cannot be resumed if the printer
runs out of paper while printing. To avoid this, load more sheets of paper
than required for the number of images to be printed.

After using the recommended solution to clear the error, press the [Resume] button
to resume printing.

Printer is not responding. Check the printer power connection,

make sure the printer is switched on, and then try again.

Cause : No power supplied to the printer.

Correction : Make sure the indicator on the printer light is green. (= p.14)

Cause : The USB cable is not connected correctly.

Correction : Check the USB cable to make sure it is connected correctly. (= p.15)

No Paper Cassette has been found. Insert an appropriate Paper
Cassette.

Cause : The paper cassette is not inserted.

Correction : Insert the paper cassette into the printer.
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Wrong type of paper. Replace the Paper.

Cause : The paper is not suitable for the print settings.

Correction : Replace the paper with the correct size.

Wrong type of Paper Cassette. Check the Paper Cassette.

Cause : The paper cassette in the printer is not suitable for the print
settings.

Correction : Insert the correct paper cassette.

The specified Ink Cassette cannot be found.
Replace the Ink Cassette.

Cause : The ink cassette in the printer is not suitable for the print
settings.

Correction : Insert the correct ink cassette.

The specified Ink Cassette and Paper cannot be found.
Replace the Ink Cassette and Paper.

Cause : The ink cassette and paper in the printer are not suitable for the
print settings.

Correction : Insert the correct ink cassette and paper.

The battery capacity of the printer is insufficient.

Please connect AC adapter,
or stop printing and replace the battery.

Cause : The printer’s battery charge is running low. The printer will not
work.

Correction : Use a new or fully charged battery pack, or use the printer with the
AC adapter (compact adapter) connected.
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M Errors where printing is canceled

If any of the following messages appear, printing is canceled. After using the
recommended solution to clear the error, you need to start the print job over
again.

Paper jammed in printer.
Clear the jam as follows, then try printing again.

1. Remove the paper that caused the error.
2. Turn printer off and back on.

Cause : Paper is jammed inside the printer while printing, or there is
paper still inside the printer before printing starts.

Correction : After closing the dialog, turn the printer off and then back on again.
Paper is automatically ejected from the print receptacle or the paper
handling slot. Remove the paper and then turn the printer off and
back on again a second time, and start the print job over.

Problem with ink cassette.
Correct as follows, then try printing again.
1. Check the state of the ink cassette.

2. Turn printer off and back on.
3. Remove the paper that caused the error.

Cause : There is a problem with the ink cassette.

Correction : Take out the ink cassette from the printer. Remove any slack from the
ink sheet and then insert the ink cassette back into the printer. If the
problem still continues, replace the ink cassette with a new one.

Communication error. Switch the printer off and on again, and then

start the print job again.

Cause : There is a problem with communications.

Correction : Turn printer off and back on.
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Error in printer.

Turn printer off and back on, then try printing again.

Cause : The printer was not initialized successfully.

Correction : Turn printer off and back on, then try printing again.

Cause : There is too much paper in the paper cassette.

Correction : Remove paper from the paper cassette, and then make sure to load
the correct amount of paper in the paper cassette.

In other cases, such as when you specify output for a file or other errors related to
your system occur, follow the error messages displayed to proceed.

CDP-E032 © 2004 CANON INC.
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